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MS Excel 
 

The Excel Screen 
 
Objective To identify the parts of the Excel screen, and know how to use them effectively. 

Instructions You will learn the parts of the Excel screen by observation and try out some common 
Excel tasks. 

 

Activity 2.1 Familiarise yourself with the Excel worksheet window. If the worksheet is displayed on 
part of the screen, you can enlarge the worksheet window by clicking on the Maximise box to the 
right of the Title Bar. 

 

Activity 2.2 The columns are labelled by letters and the rows by numbers. At the intersection of a 
row with a column is a box called a cell. Cells are referenced by both their column label and their 

row number.  

Click on the cell D7 using the mouse. A black box appears around the cell. This is called the cell 
highlight and it's presence denotes a selected range. Move the mouse slowly over the black border. 
Notice that the cursor changes from a thick white crosshair when over the main part of the cell to 
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a white arrow when it is over the black border, and a black crosshair when it is over the little 
black box in the bottom right hand corner of the cell highlight. 

Activity 2.3 Now look at the formula bar. This has three areas. The lefthand area will have the text 
D7 in it. Excel can only edit the contents of one cell at a time, even when a range is selected. The 
editable cell is called the active cell. It is always highlighted and it's reference will be displayed in 
the left-hand area of the formula bar. 

The right-hand area of the formula bar will display the contents of the active cell, and in here the 
contents can be changed. The middle area of the formula bar is used when the cell is being edited to 
confirm or cancel the changes.  
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Microsoft Excel is an electronic spreadsheet program. 
 
The Workbook  
 
Most of the Excel screen is devoted to the display of the workbook. The workbook consists of 
grids and columns. The intersection of a row and column is a rectangular area called a cell.  
 
Cells  
 
The workbook is made up of cells. There is a cell at the intersection of each row and column. A 
cell can contain a value, a formula, or a text entry.  
 
Rows, Columns, and Sheets  
 
The Excel worksheet contains 16,384 rows that extend down the worksheet, numbered 1 
through 16384.  
 
The Excel worksheet contains 256 columns that extend across the worksheet, lettered A 
through Z, AA through AZ, BA through BZ, and continuing to IA through IZ.  
 
The Excel worksheet can contain as many as 256 sheets, labeled Sheet1 through Sheet256. 
The initial number of sheets in a workbook, which can be changed by the user is 16.  
 
Cell References  
 
Cell references are the combination of column letter and row number. For example, the 
upper-left cell of a worksheet is A1. 

Formulas 

Formulas are entered in the worksheet cell and must begin with an equal sign "=". The formula 
then includes the addresses of the cells whose values will be manipulated with appropriate 
operands placed in between. 

Basic Functions 

Functions can be a more efficient way of performing mathematical operations than formulas. 
For example, if you wanted to add the values of cells D1 through D10, you would type the 
formula "=D1+D2+D3+D4+D5+D6+D7+D8+D9+D10". A shorter way would be to use the 
SUM function and simply type "=SUM(D1:D10)". Several other functions and examples are 
given in the table below: 

Function Example Description 

SUM =SUM(A1:100) finds the sum of cells A1 through A100 

AVERAGE =AVERAGE(B1:B10) finds the average of cells B1 through B10 

MAX =MAX(C1:C100) 
returns the highest number from cells C1 through 
C100 

MIN =MIN(D1:D100) returns the lowest number from cells D1 through D100 

SQRT =SQRT(D10) finds the square root of the value in cell D10 

TODAY =TODAY() returns the current date (leave the parentheses 
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empty) 

Function Wizard  

View all functions available in Excel by using the Function Wizard. 

 Activate the cell where the function will be placed and click the Function Wizard button 
on the standard toolbar.  

 From the Paste Function dialog box, browse through the functions by clicking in the 
Function category menu on the left and select the function from the Function name 
choices on the right. As each function name is highlighted a description and example of 
use is provided below the two boxes. 

 

 

 Click OK to select a function.  
 The next window allows you to choose the cells that will be included in the function. In 

the example below, cells B4 and C4 were automatically selected for the sum function by 
Excel. The cell values {2, 3} are located to the right of the Number 1 field where the 
cell addresses are listed. If another set of cells, such as B5 and C5, needed to be added 
to the function, those cells would be added in the format "B5:C5" to the Number 2 
field. 
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 Click OK when all the cells for the function have been selected.  

 
 

Creating Charts 

 
 
 
Before you can draw a chart using Excel, the numbers that compose the chart must be entered 
in a workbook. There are five general steps in defining a chart.  
 
Steps in Creating a Chart:  

1. Enter the numbers into a workbook.  

2. Select the data to be charted.  

3. Choose Chart from the Insert menu.  

4. Choose either Chart Type from the Format menu or click on the ChartWizard button.  

5. Define parameters such as titles, scaling color, patterns, and legend.  

These five steps should be performed in this order. Note that since the chart is linked to the 

workbook data, any subsequent changes made to the workbook are automatically reflected in 

the chart.  
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Creating a Pie Chart 
 
Pie charts are used to show relative proportions of the whole, for one data series only.  
 
Data series is a group of related data points.  
 
A data point is a piece of information that consists of a category and value.  
 
When you create a chart with Excel, the categories are plotted along the horizontal or X-axis, 
while the values are plotted along the vertical or Y-axis.  
 
Data series originate from single worksheet rows or columns. Each data series in a chart is 
distinguished by a unique color or pattern. You can plot one or more data series in a chart 
except for pie charts.  
 
An example of a data series is the population of the United States over ten years. Each data 
point would be made up of a year (the category) and the population in that year (value).  
 
The first step in creating any chart is to enter the data on a workbook.  
 
1. Find and open MS Excel if it is not already open.  
 
2. Make sure your toolbars and formula bar is displayed.  
 
3. Open a new workbook.  
 
4. Save your workbook and name it "expenses".  
 
Enter the following into expenses workbook:  
 
 

 
 
You will be using the ChartWizard to create your pie chart.  
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Step 1: Select the data you just entered.  
 
Step 2: Choose Chart from the Insert menu.  
 
Step 3: Observe that the ChartWizard's first dialog box appears:  
 
 

 
 
You want a regular pie chart not a 3-D pie chart.  
 
Step 4: Select the chart type: Pie and click on the Next button.  
 
The following dialog should appear:  
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Step 5: Read the dialog box, make sure the range is correct and then click the Next 
button.  
 
 
The following dialog should appear:  
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Step 6: Select the Titles tab and then enter "Weekly Expenses" as the chart title.  
 
Step 7: Select the Legend tab and make the following adjustments:  
 

 
 
Step 8: Select the Data Labels tab and select the following options:  
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Step 9: Select the following options and then click the Finish button.  
 
 

 
 
 
 
Your expenses workbook should look as follows:  
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Step 10: Save your changes.  
 
 

 
 

 

AutoFilter  

 
 

For medium-to-large quantities of data, using Microsoft Excel’s AutoFilter is a quick and simple 
way to filter through that information and find what you need. 

Steps 

1. Input all of your data, or open the spreadsheet that contains all of your data. It is best 
that your data have column heading such as categories to specify the data below it. If 
you don’t already have these, input them before you filter. 
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2. Select all the data you wish to filter. 

 

3. Click “Data”, then “Filter” which opens a sub-menu, then click “AutoFilter”. 
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4. You will immediately notice that the categories have drop-down buttons. Using these 
buttons, you can set your filter options. 

 

o Sort Ascending: sorts data in ascending order based on the data in that column;  
o Sort Descending: sorts data in descending order based on the data in that 

column; 
o All: the default filter option, sorts data as it was originally entered into the 

spreadsheet; after filtering, return to this option to view data in its original order 
and format 

o Top 10: The first 10 rows of data in your spreadsheet (when initial setting is 
“All”) or the first 10 rows of data from the filtered selection 

o Custom: You may customize how Excel sorts the data based on data ranges and 
information. 

o Various data points: You may sort the data based on all other data points in that 
column. Excel combines data points that are the same. For example, employees 
that live in the same city can be sorted using only one data point. 
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5. To turn off AutoFilter, repeat step 3 to uncheck the AutoFilter option. 

 

Macros  

 

Recording A Macro 

Macros can speed up any common editing sequence you may execute in an Excel spreadsheet. 
In this example we will make a simple macro that will set all the margins on the page to one 
inch. 

Click Tools|Macro|Record New Macro from the menu bar. 

 

 

 Name the macro in the Macro name field. The name cannot contain spaces and must 

not begin with a number.  
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 If you would like to assign a shortcut key to the macro for easy use, enter the letter 

under Shortcut key. Enter a lower case letter to make a CTRL+number shortcut and 

enter an upper case letter to assign a CTRL+SHIFT+number shortcut key. If you select a 

shortcut key that Excel already uses, your macro will overwrite that function.  

 Select an option from the Store macro in drop-down menu.  

 Enter a description of the macro in the Description field. This is for your reference only 

so you remember what the macro does.  

 Click OK when you are ready to start recording.  

 Select options from the drop down menus and Excel will record the options you choose 

from the dialog boxes, such as changing the margins on the Page Setup window. Select 

File|Page Setup and change all the margins to 1". Press OK. Replace this step with 

whatever commands you want your macro to execute. Select only options that modify 

the worksheet. Toggle actions such as View|Toolbars that have no effect on the 

worksheet will not be recorded. 

 

 

 Click the Stop button the recording toolbar. The macro is now saved.  

 

Running A Macro 

 To run a macro you have created, select Tools|Macro|Macros from the menu bar.  
 From the Macros window, highlight the Macro name in the list and click Run. 
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 If the macro is long and you want to stop it while it is running, press BREAK (hold CTRL 
and press PAUSE).  

 

 

 

 

 

 

 

 

 



 Information Technology Lab (MS Office) 

                                     
                                            RONALD ROSS P.G COLLEGE 

24

 

Printing 
 
Objective To control the printing options. 

Instructions You will use the Page Setup, Print Preview and Print commands from the File menu. 

Comments Having gone to all this work to create your spreadsheet, you will want to take away a 
printed copy. 

 
Activity 10.1 Before printing, you will need to ensure that Excel is 'talking' the right printer 
language and attached to the correct printer queue. To do this you should consult the document 
Getting Started with Microsoft Windows (BEG 2). 

Activity 10.2 Once the right printer has been selected, you will probably want to check how your 
page is set up. Select the Page Setup... command from the File menu. You should get the dialogue 
box as shown below: 

 

Click on the Centre Horizontally and Centre Vertically check boxes. Then click <OK>. 

Activity 10.3 We will now preview the spreadsheet on screen. Previewing your spreadsheet, before 
committing it to the printer saves you time, effort and money so it is recommended. As a precaution 
you are advised to save your work beforehand. 

From the File menu choose the Print Preview command. The screen will display a preview of the 
printout. To examine the worksheet more closely, click on the Zoom button. When you are satisfied 
with the Preview, click on the <Print> button. The spreadsheet window will reappear with a dialogue 
box checking that you are sending the print to the right place, how much of the sheet you want 
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printed and how many copies. Click <OK> and a small dialog box appears giving the progress of the 
printing. Wait until this disappears before continuing with your work.  

NPV PROJECT 

 This segment will show you how to determine the NET PRESENT VALUE (NPV) of a series of 
cash flows. 

In this example we have a series of cash flows starting at the beginning of Period 1, which we called 
Period 0. An outflow of 20 000, and then the next five years we have inflows of cash. 

We would like to determine what the NET PRESENT VALUE is of these series of cash flows. In 
order to do this we can make use of the NET PRESENT VALUE function. 

• if we click on the cell  
• and go the Function Wizard 
• go into the Financial categories  
• and find the NPV function  
• This will appear, we are asked to fill it in. 
• The first criteria is to give it a Rate, which is a rate of discount over the length of one period. 

In this case it’s this cell here,  
• we now need to enter the Values and if you click on the first one you’ll see that it tells you 

here its Value 1, 2 all the way up to 29 of income, equally space in time and occurring at the 
end of each period. 

Now this is very, very important because if you look at our numbers, Period 0 is actually the 
beginning of Period 1 and then Period 1 that’s the end, the end, the end. 

If we assume the values of all these cells we’ll be incorrect because Excel will assume that this 20 
000 investment actually occurs at the end of Period 1. So in order to do this is our Value 1  

• we highlight all cash flows that happen at the end of the period  
• and when we push Ok  
• you’ll see we get a NET PRESENT VALUE 

However we have to be very careful because what we’ve told it to do, is give us the NET PRESENT 
VALUE of all the cash flows at the end of the years. We have excluded this, now because it happens 
at the beginning of Period 1 we don’t have to worry about present valuing it because the number is 
already present values.  

So in order to get an accurate NET PRESENT VALUE, you need to subtract the initial investment. 
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• so you’ll see we’ve got a cell here for Initial Investment,  
• you make that, equal to the beginning period  
• when we push enter  
• you’ll see I’ve summed these two,  

so the NET PRESENT VALUE of these series of cash flows is actually this number here. 

Returns the internal rate of return for a series of cash flows represented by the numbers in values. 
These cash flows do not have to be even, as they would be for an annuity. However, the cash flows 
must occur at regular intervals, such as monthly or annually. The internal rate of return is the interest 
rate received for an investment consisting of payments (negative values) and income (positive 
values) that occur at regular periods. 

 

IRR(values,guess) 

Values   is an array or a reference to cells that contain numbers for which you want to calculate the 
internal rate of return. 

• Values must contain at least one positive value and one negative value to calculate the 
internal rate of return. 

• IRR uses the order of values to interpret the order of cash flows. Be sure to enter your 
payment and income values in the sequence you want. 

• If an array or reference argument contains text, logical values, or empty cells, those values 
are ignored. 

Guess   is a number that you guess is close to the result of IRR. 

• Microsoft Excel uses an iterative technique for calculating IRR. Starting with guess, IRR 
cycles through the calculation until the result is accurate within 0.00001 percent. If IRR can't 
find a result that works after 20 tries, the #NUM! error value is returned. 

• In most cases you do not need to provide guess for the IRR calculation. If guess is omitted, it 
is assumed to be 0.1 (10 percent). 

• If IRR gives the #NUM! error value, or if the result is not close to what you expected, try 
again with a different value for guess. 

Remarks 

IRR is closely related to NPV, the net present value function. The rate of return calculated by IRR is 
the interest rate corresponding to a 0 (zero) net present value. The following formula demonstrates 
how NPV and IRR are related: 

NPV(IRR(B1:B6),B1:B6) equals 3.60E-08 [Within the accuracy of the IRR calculation, the value 
3.60E-08 is effectively 0 (zero).] 
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Example 

The example may be easier to understand if you copy it to a blank worksheet. 

How to copy an example 

1. Create a blank workbook or worksheet. 
2. Select the example in the Help topic.  

Note  Do not select the row or column headers. 

 

Selecting an example from Help 

3. Press CTRL+C. 
4. In the worksheet, select cell A1, and press CTRL+V. 
5. To switch between viewing the results and viewing the formulas that return the results, press 

CTRL+` (grave accent), or on the Tools menu, point to Formula Auditing, and then click 
Formula Auditing Mode. 

   
1 
2 
3 
4 
5 
6 
7  

A B 
Data Description 

-70,000 Initial cost of a business 
12,000 Net income for the first year 
15,000 Net income for the second year 
18,000 Net income for the third year 
21,000 Net income for the fourth year 
26,000 Net income for the fifth year 

Formula Description (Result) 
=IRR(A2:A6) Investment's internal rate of return after four years (-2%) 
=IRR(A2:A7) Internal rate of return after five years (9%) 
=IRR(A2:A4,-
10%) 

To calculate the internal rate of return after two years, you need to include a 
guess (-44%)  
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Date Formulas and Functions 
• Today's date and time: =NOW()  

• Today's date only:         =TODAY()  

• Day of the month for a specific date: =DAY(TODAY())  

• Day of the week for a specific date (set the cell format to custom format "dddd"):  

                                      =WEEKDAY(TODAY()) 

=TEXT(WEEKDAY(TODAY()),"dddd") 

• Month of the year for a specific date: =MONTH(TODAY())  

• Year for a specific date: =YEAR(TODAY())  

• Date for a specific year, month and day (Example returns 6/12/2005):   

                  =DATE(2005,6,12)  

• Add days to a date (one week from today):  =TODAY()+7  

• Subtract days from a date (one week ago today):  =TODAY()-7 

• Last day of the this month: =DATE(YEAR(TODAY()),MONTH(TODAY())+1,1)-1  

or 

       = EOMONTH(TODAY(),0)  

• Last workday of the current month:  

=WORKDAY(DATE(YEAR(TODAY()),MONTH(TODAY())+1,1),-1,Holidays)  

• First workday of the following month:  

=WORKDAY(DATE(YEAR(TODAY()),MONTH(TODAY())+1,1)-1,1,Holidays)  

• Number of workdays in the current month:  

=NETWORKDAYS(DATE(YEAR(TODAY()),MONTH(TODAY()),1),EOMONTH(TODAY(),
0),Holidays)  
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• Last workday in range of days (A1 is start date, B1 is number of days in the period): 
=WORKDAYS(A1,B1,Holidays)  

DATEDIF() Syntax & Examples  
The DATEDIF() function uses the following syntax:  

=DATEDIF(start_date,end_date,"code")  

The start date must be less than the end date, or the function returns an error.  

The following are the codes for the DATEDIF() function:  

• "y" Years 
• "m" Months 
• "d" Days 
• "md" Difference between days in a period; no month and years  
• "ym" Difference between the months in a period, no days and years  
• "yd" Difference between the days in a period, no years  

Examples 

• To calculate the number of years between two dates: 

=DATEDIF(A1,TODAY(),"y") & " Years"  

• To calculate the number of years and months between two dates: 

=DATEDIF(A1,TODAY(),"y") & " Years, " & DATEDIF(A1,TODAY(),"ym") & " Months"  

• To calculate the number of years, months, and days between two dates: 

=DATEDIF(A1,TODAY(),"y") & " Years, " & DATEDIF(A1,TODAY(),"ym") & " Months, " 
& DATEDIF(A1,TODAY(),"md") & " Days"  

Using the TEXT() function to calculate dates.  
You can use the TEXT() to get the number of days or weeks between two dates:  

Examples 

• Number of days: 

=VALUE(TEXT((NOW()-$A$1)/24,"[h]"))  

• Number of weeks: 
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=VALUE(TEXT((NOW()-$A$1)/168,"[h]"))  

 
Using Date and Time Functions in Excel 2002 

Have you ever wondered how long it has been since the first day of 1900? Maybe you haven’t, but 
the designers of Microsoft Excel decided to base their time and date functions on this day. Trying to 
determine the date exactly 1000 days from today without a computer requires the use of several 
calendars and a lot of time. With the use of a spreadsheet program, such as Excel, the exact day can 
be displayed in moments. In this article, you will examine and use many of the date and time 
functions built into Excel.  

When a date is entered into a worksheet cell, Excel immediately converts the date into a serial 
number. January 1, 1900 is serial number 1 and the serial number of the date entered is the number 
of days since January 1, 1900. In Figure 1, three dates entered into cells in column A have been 
copied into column B. The only difference is that the dates in column B appear in the General format 
rather than a Date format.  

 

Figure 1 

Regardless of the format of the date, the value in memory is the serial number. Using date and time 
functions and arithmetic operators you may find the difference between two dates, determine the day 
of the week three months from the current day, or find the number of workdays within a given range 
of dates, excluding Saturday, Sunday, and holidays. Date and time functions in Excel fall into 
several categories, each of which is explored in the following sections.  

Just Give Me the Number 

 
Type in a date, as in 1/18/2002, and Excel immediately converts it into a date serial number. But 
what if you have the month, day, and year in different cells? The Date function requires three 
arguments, the month, the day, and the year. You can type in the pieces of the date directly into the 
function, or use the cell addresses containing the components. Figure 2 illustrates both ways to use 
the Date function. Note that the order of the arguments is the year, followed by the month, and 
finally the day. If you enter the date directly into the function, each of the arguments must be 
enclosed within quotation marks.  
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Figure 2 

The Datevalue function works in much the same way, except it only has one argument — the date 
you want to convert, enclosed within quotation marks, in the yyyy/mm/dd format. An example is 
DATEVALUE(“2001/11/14”).  

Excel can also display the time with or without the date. As far as Excel is concerned, the time is no 
more than a fraction of a day. For instance, .5 days is 12 noon, .25 is 6 a.m., and so on. You can use 
the Time and Timevalue functions to display the time either by entering the time directly into the 
function or by referencing the time in cells. Figure 3 shows the Time functions, and the result in 
both the General and the Time format. The Timevalue function lets you enter the time as hours, 
minutes, seconds as in TIMEVALUE(“10:15:00”) for 10:15 a.m.  

 

Figure 3 

There are two special functions useful when you want your worksheet to display the current date 
and/or time whenever the worksheet is opened. The Today function displays the current day in the 
mm/dd/yyyy format. Although you must type in the parentheses after the function, you must not 
enter any arguments. Therefore, TODAY() will display 2/13/2002 on February 13, 2002, 12/9/2005 
on December 9, 2005, and so on. The Now function does the same thing as the Today function, 
except the result is formatted to display the current time as well as the current date. Like the Today 
function, the Now function has no arguments, as in NOW(). 
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Give Me a Piece of That 
Sometimes you have to take a date serial number and convert it into a value that is more meaningful 
to people. For example, the Day function displays just the day of the month of a date, regardless of 
the format of the date. Likewise, the Month, Year, Hour, Minute, and Second functions extract a 
portion of the date or time. Figure 4 illustrates each of these functions.  

 

Figure 4 

When Will That Be? 

 
The above functions are the “plain vanilla” functions essential to many worksheets. Using these 
functions, and others, you can display and calculate the difference between dates, add or subtract 
days from a given date, and so on. But there are a number of specialized functions that perform tasks 
that would otherwise require many calculations and logical operations. For instance, the Weekday 
function returns the day of the week in which the date in the argument falls, 1 being Sunday, 2 
Monday, 3 Tuesday, and so on. Another function, Weeknum, tells you the number of the week that a 
date falls within.  

Then there are a group of functions that use two dates in their arguments, especially handy in 
accounting applications. Days360 figures out the number of days between two dates, based on a 360-
day calendar (12, 30-day months). Yearfrac determines the fraction of a year represented by the two 
dates in the argument. Figure 5 shows examples of these functions.  
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Figure 5 

Accounting solutions may depend on determining the date a specified number of months away or the 
last day of that month. Edate uses two arguments — the start date and the number of months until 
the same day of another month. For example, the Edate of 2/7/2003 with a second argument of 2 
would be 4/7/2003 — the same day two months away. If the second argument is a negative number, 
the answer is a date in the past. So, EDATE(B12,-3) would be a date three months before the date in 
cell B12.  

Eomonth works just like Edate except it finds the last day of the month. Just as with Edate, the 
arguments are the start date and the number of months before or after the start date. Therefore, 
EOMONTH(C15,5) would return the date May 31, 2002 if the start date in C15 was any day in 
January 2002.  

Finally, there are two date functions that can be very useful to accounting and human resource 
departments, among others — Workday and Networkdays. The Workday function finds the next 
workday from a specified date, excluding holidays. The function has three arguments — the start 
date, the number of days before or after the start date, and a range of cells containing holidays that 
should not be considered as work days. Networkdays calculates the number of work days between a 
start date and an end date, again excluding holidays. Check out the examples in Figure 6 to see these 
amazing functions in action.  
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MS Access 
 

Access version 1.0 was released in November 1992, quickly followed in May of 1993 by an Access 
1.1 release to improve compatibility with other Microsoft products and include the Access Basic 
programming language. 

Microsoft specified the minimum hardware requirements for Access v2.0: Microsoft Windows v3.0 
with 4 MB of RAM required, 6 MB RAM recommended; 8 MB of available hard disk space 
required, 14 MB hard disk space recommended. The product was shipped on seven 1.44 MB 
diskettes. The manual shows a 1993 copyright date. 

Originally, the software worked well with relatively small databases but testing showed some 
circumstances caused data corruption. For example, file sizes over 10 MB were problematic (note 
that most hard disks were smaller than 500 MB at the time this was in wide use), and the Getting 
Started manual warns about a number of circumstances where obsolete device drivers or incorrect 
configurations can cause data loss. With the phasing out of Windows 95, 98 and ME, improved 
network reliability, and Microsoft having released 8 service packs for the Jet Database Engine, the 
reliability of Access databases has been vastly improved in both size and number of users. 

With Office 95, Microsoft Access 95 became part of the Microsoft Office Professional Suite joining 
Microsoft Excel, Word, and PowerPoint and transitioning from Access Basic to Visual Basic for 
Applications (VBA). Since then, there have been releases of Microsoft Access with each release of 
Office. This includes Access 97 (version 8.0), Access 2000 (version 9.0), Access 2002 (version 
10.0), Access 2003 (version 11.0), and Access 2007 (version 12.0). 

The native Access database format (the Jet MDB Database) has also evolved over the years. Formats 
include Access 1.0, 1.1, 2.0, 95, 97, 2000, and 2002-2007. The most significant transition was from 
the Access 97 to the Access 2000 format which was not backward compatible, and Access 2000 
required the new format. Since Access 2000, all newer versions of Access support the Access 2000 
format. New features were added to the Access 2002 format which can be used by Access 2002, 
2003, and 2007. 

In Access 2007, a new database format was introduced: ACCDB. The ACCDB supports complex 
data types such as multivalue and attachment fields. These new field types are essentially recordsets 
in fields and allow the storage of multiple values in one field. 

Access's initial codename was Cirrus; the forms engine was called Ruby. This was before Visual 
Basic - Bill Gates saw the prototypes and decided that the BASIC language component should be co-
developed as a separate expandable application, a project called Thunder. The two projects were 
developed separately as the underlying forms engines were incompatible with each other; however, 
these were merged together again after VBA. 

Prior to the introduction of Access, the desktop database market was dominated by Borland with 
their Paradox and dBase programs, and FoxPro. Microsoft Access was the first mass market 
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database program for Windows. With the purchase of FoxPro and incorporating its Rushmore query 
optimization routines into Access, Microsoft Access quickly became the dominant database for 
Windows effectively eliminating the competition which failed to transition from the MS-DOS 
world[1]. 

 

Access is a database program that stores information that can be manipulated, sorted, and 
filtered to meet your specific needs. 

 A database is a collection of related information.  
 An object is a competition in the database such as a table, query, form, or macro.  
 A table is a grouping of related data organized in fields (columns) and records (rows) on 

a datasheet. By using a common field in two tables, the data can be combined. Many 
tables can be stored in a single database.  

 A field is a column on a datasheet and defines a data type for a set of values in a table. 
For a mailing list table might include fields for first name, last name, address, city, state, 
zip code, and telephone number.  

 A record in a row on a datasheet and is a set of values defined by fields. In a mailing 
list table, each record would contain the data for one person as specified by the 
intersecting fields.  

 

Tables  

 

Tables are grids that store information in a database similar to the way an Excel worksheet 
stores information in a workbook. Access provides three ways to create a table for which there 
are icons in the Database Window. Double-click on the icons to create a table. 

 
the Database Window 
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 Create table in Design view will allow you to create the fields of the table. This is the 
most common way of creating a table and is explained in detail below.  

 Create table using wizard will step you through the creation of a table.  
 Create table by entering data will give you a blank datasheet with unlabelled columns 

that looks much like an Excel worksheet. Enter data into the cells and click the Save 
button.   

Creating a Table in Design View 

Design View will allow you to define the fields in the table before adding any data to the 
datasheet. The window is divided into two parts: a top pane for entering the field name, data 
type, and an option description of the field, and a bottom pane for specifying field properties. 

 

 Field Name - This is the name of the field and should represent the contents of the field 
such as "Name", "Address", "Final Grade", etc. The name can not exceed 64 characters 
in length and may include spaces.  

 Data Type is the type of value that will be entered into the fields. 
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 Text - The default type, text type allows any combination of letters and numbers 

up to a maximum of 255 characters per field record. 

 Memo - A text type that stores up to 64,000 characters. 

 Number - Any number can be stored. 

 Date/Time - A date, time, or combination of both. 

 Currency - Monetary values that can be set up to automatically include a dollar 

sign ($) and correct decimal and comma positions. 

 AutoNumber - When a new record is created, Access will automatically assign a 

unique integer to the record in this field 

 Yes/No - Use this option for True/False, Yes/No, On/Off, or other values that 

must be only one of two. 

 OLE Object - An OLE (Object Linking and Embedding) object is a sound, picture, 

or other object such as a Word document or Excel spreadsheet that is created in 

another program. Use this data type to embed an OLE object or link to the object 

in the database. 

 Description (optional) - Enter a brief description of what the contents of the field are.  

 

Queries  

 

Queries select records from one or more tables in a database so they can be viewed, analyzed, 
and sorted on a common datasheet. The resulting collection of records, called a dynaset (short 
for dynamic subset), is saved as a database object and can therefore be easily used in the 
future. The query will be updated whenever the original tables are updated.  

Creating a Query in Design View 

Follow these steps to create a new query in Design View: 

 From the Queries page on the Database Window, click the New button. 
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 Select Design View and click OK.  

 Select tables and existing queries from the Tables and Queries tabs and click the Add 

button to add each one to the new query.  

 Click Close when all of the tables and queries have been selected. 
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 Add fields from the tables to the new query by double-clicking the field name in the 
table boxes or selecting the field from the Field: and Table: drop-down menus on the 
query form. Specify sort orders if necessary. 

 

 

 Enter the criteria for the query in the Criteria: field. The following table provides 
examples for some of the wildcard symbols and arithmetic operators that may be used. 

The Expression Builder can also be used to assist in writing the expressions. 

Query Wildcards and Expression Operators  

Wildcard / 
Operator 

Explanation 

? Street The question mark is a wildcard that takes the place of a single 
letter. 

43th * The asterisk is the wildcard that represents a number of 
characters. 

<100 Value less than 100 

>=1 Value greater than or equal to 1 

<>"FL" Not equal to (all states besides Florida) 
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Between 1 and 10 Numbers between 1 and 10 

Is Null 
Is Not Null 

Finds records with no value 
or all records that have a value 

Like "a*" All words beginning with "a" 

>0 And <=10 All numbers greater than 0 and less than 10 

"Bob" Or "Jane" Values are Bob or Jane 

 After you have selected all of the fields and tables, click the Run button on the toolbar.  
 Save the query by clicking the Save button.  

 

Forms  

 

Forms are used as an alternative way to enter data into a database table. 

Creating a Form by Using Wizard 

To create a form using the assistance of the wizard, follow these steps: 

 Click the Create form by using wizard option on the database window.  

 From the Tables/Queries drop-down menu, select the table or query whose datasheet 

the form will modify. Then, select the fields that will be included on the form by 

highlighting each one the Available Fields window and clicking the single right arrow 

button > to move the field to the Selected Fields window. To move all of the fields to 

Select Fields, click the double right arrow button >>. If you make a mistake and would 

like to remove a field or all of the fields from the Selected Fields window, click the left 

arrow < or left double arrow << buttons. After the proper fields have been selected, 

click the Next > button to move on to the next screen. 
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 On the second screen, select the layout of the form. 

 

 Columnar - A single record is displayed at one time with labels and form fields 
listed side-by-side in columns  

 Justified - A single record is displayed with labels and form fields are listed 
across the screen  

 Tabular - Multiple records are listed on the page at a time with fields in columns 
and records in rows  

 Datasheet - Multiple records are displayed in Datasheet View  

Click the Next > button to move on to the next screen. 
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 Select a visual style for the form from the next set of options and click Next >. 

 

 

 On the final screen, name the form in the space provided. Select "Open the form to view 
or enter information" to open the form in Form View or "Modify the form's design" to 
open it in Design View. Click Finish to create the form. 
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Reports 

 

Reports will organize and group the information in a table or query and provide a way to print 
the data in a database. 

Creating a Report by Using the Wizard 

Create a report using Access' wizard by following these steps: 

 Double-click the "Create report by using wizard" option on the Reports Database 
Window.  

 Select the information source for the report by selecting a table or query from the 
Tables/Queries drop-down menu. Then, select the fields that should be displayed in 
the report by transferring them from the Available Fields menu to the Selected Fields 
window using the single right arrow button > to move fields one at a time or the double 
arrow button >> to move all of the fields at once. Click the Next > button to move to 
the next screen.  
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 Select fields from the list that the records should be grouped by and click the right arrow 
button > to add those fields to the diagram. Use the Priority buttons to change the 
order of the grouped fields if more than one field is selected. Click Next > to continue.  
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 If the records should be sorted, identify a sort order here. Select the first field that 
records should be sorted by and click the A-Z sort button to choose from ascending or 
descending order. Click Next > to continue. 

 

 

 

 Select a layout and page orientation for the report and click Next >.  
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 Select a color and graphics style for the report and click Next >. 

 

 

 On the final screen, name the report and select to open it in either Print Preview or 
Design View mode. Click the Finish button to create the report. 
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Macros  
 
 
 
When you want to control the flow of activities in the application there are several ways you can 
go. We'll look at a couple of them. 
 
First, if you don't want to use the Menu Manager discussed in the previous lesson, you can create 
your own menu using a simple form, as in the example below. 
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If you only have a form with buttons, nothing much will happen. You have to tell the application 
what to do when a button is clicked. That's what macros are for. 
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It's important to save the macro and name it. Give it the same name as the form it's on. That will 
simplify your life later. If you use macros you'll probably end-up with dozens in the application. 
Trust me: if you use names like macro1 and macro2 and so on, you'll tear your hair out later in trying 
to find what each one does. So, name the macro the same as the form it's on and name the actions 
inside the macro the same as the buttons. 
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Macros can also be used to open a form from another form.  
 
For example, if you have to change the customer's address while the customer is renting a movie, 
you don't do the change in the Invoice form. You call the Customers form from the Invoice form. 
The trick is to make sure that the Customers form that opens is the one for the customer who is on 
the invoice.  
 
We could create a macro for that. 
 
However, it's more easily done by using the Wizard. Make sure the Wizard is activated in the 
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Toolbox (the magic wand) and it will be called automatically when you create the button.  
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Finally, you should add navigation buttons to all forms. 
 
You may have noticed that the navigation bar at the bottom of every form, although it is functional, 
it is small and hard to work. Adding navigation buttons makes it easier for the user. 
 
Every form should have the standard buttons: First, Previous, Next, Last, New record, Close form 
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Using reports  
 
Reports are printed documents showing information from the database. 
 
Like forms, reports can be based on tables or queries. However, unlike forms, reports are for output 
only. Obviously, since they are output to the printer, reports cannot accept input from the user. 
 
 

 

Creating the report  
 
Before you launch the report editor, know where the information for the report is coming from. 
 
Actually it would be helpful to draw a draft on paper (with a pencil!) to show where to put the 
columns, how to align them, where to put totals, etc. 
 
If the data is in several tables, you will first create a query to get everything together. 
 
Using the Report wizard is the easiest way of building the report. 
 
The normal form is called tabular, meaning that the information will appear as a table with headings 
at the top of the page. 
 
For the first example we will print a simple list of customers. 
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 Information Technology Lab (MS Office) 

                                     
                                            RONALD ROSS P.G COLLEGE 

64

 
 
 
 
 

Editing the report  
 
 
 
In design mode you can edit the layout of the report. 
 
The first draft, created by the Wizard, needs some work. To fit all the columns on the page, some has 
to be shortened, etc. 
 
Note that the important section is Detail. That's where the data is printed. Headers and footers 
contain headings and summaries. 
 
The height of each section can be adjusted by clicking on the lower margin of the section. 
 
You edit the contents of the headings, titles, etc. like on the form editor. 
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